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Introduction 

The GFLUX driver enables communication between the Studio system and Gammaflux TTC devices using the 

Gammaflux TTC Auxiliary protocol communicating over Serial, according to the specifications discussed in this 

document.  

This document was designed to help you install, configure, and execute the GFLUX driver to enable 

communication with these devices. The information in this document is organized as follows: 

 Introduction: Provides an overview of the GFLUX driver documentation. 

 General Information: Provides information needed to identify all the required components (hardware and 

software) used to implement communication between Studio and the GFLUX driver.  

 Installing the Driver: Explains how to install the GFLUX driver. 

 Configuring the Driver: Explains how to configure the GFLUX driver. 

 Executing the Driver: Explains how to execute the driver to verify that you installed and configured the driver 

correctly.    

 Troubleshooting: Lists the most common error codes for this protocol and explains how to fix these errors. 

 Sample Application: Explains how to use a sample application to test the GFLUX driver configuration. 

 Revision History: Provides a log of all modifications made to the driver and the documentation.  

 Notes:  

• This document assumes that you have read the “Development Environment” chapter in the Studio 
Technical Reference Manual. 

• This document also assumes that you are familiar with the Windows NT/2000/XP environment.  
If you are unfamiliar with Windows NT/2000/XP, we suggest using the Help feature (available from the 
Windows desktop Start menu) as you work through this guide.  
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General Information 

This chapter explains how to identify all the hardware and software components used to implement 

communication between the Studio GFLUX driver and the Gammaflux TTC devices.  

The information is organized into the following sections: 

 Device Characteristics 
 Link Characteristics 
 Driver Characteristics 

Device Characteristics 

To establish communication, you must use devices with the following specifications:  

 Manufacturer: Gammaflux 
 Compatible Equipment:  

– TTC family 
 Programming Software: None 

 Device Runtime Software: None 

For a list of the devices used for conformance testing, see “Conformance Testing.” 

Link Characteristics 

To establish communication, you must use links with the following specifications: 

 Device Communication Port: Serial 

 Physical Protocol: Serial RS232 

 Logic Protocol: Gammaflux TTC Auxiliary  

Driver Characteristics 

The GFLUX driver is composed of the following files: 

 GFLUX.INI: Internal driver file. You must not modify this file. 

 GFLUX.MSG: Internal driver file containing error messages for each error code. You must not modify this file.  

 GFLUX.PDF: Document providing detailed information about the GFLUX driver. 

 GFLUX.DLL: Compiled driver. 

 





Notes:  

• All of the preceding files are installed in the /DRV subdirectory of the Studio installation directory.  

• You must use Adobe Acrobat® Reader™ (provided on the Studio installation CD-ROM) to view  
the GFLUX.PDF document. 

 

You can use the GFLUX driver on the following operating systems:  

 Windows NT/2K/XP 

 Windows CE 

 

For a list of the operating systems used for conformance testing, see “Conformance Testing” on page 4.  
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The GFLUX driver supports the following registers: 

 

Register Type Length Write Read Bit Integer 

ALL (Process Temperature Value, Active % 
Output, Load Current, Load Volts and Alarm 
Status) 

5 Words    

TEMP (Process Temperature value) 1 Word    

ACTOUT (Active % Output) 1 Word    

LDCURR (Load Current) 1 Word    

LDVLT (Load Volts) 1 Word    

ALRST (Alarm Status) 1 Word    

MODE (Manual Mode) 1 Word    

CYCLE (Cycle Time) 1 Word    

PROCSETP (Process Setpoint) 1 Word    

PWRSETP (Manual % Power Setpoint) 1 Word    

ZONEST (Zone On/Off) 1 Word    

 

Conformance Testing 

The following hardware/software was used for conformance testing: 

 Driver Configuration: 

– Baud Rate: 57600 

– Data Bits: 8 

– Stop Bits: 1 

– Parity: None 

– COM Port: COM1 

 Cable: Serial RS232 

 

Driver 

Version 

Studio 

Version 

Operating 

System 
Equipment 

1.00 6.0 WinXP Gammaflux TTC 2100 device 
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Installing the Driver 

When you install Studio version 5.1 or higher, all of the communication drivers are installed automatically.  

You must select the driver that is appropriate for the application you are using. 

Perform the following steps to select the driver from within the application: 

1. Open Studio from the Start menu.  

2. From the Studio main menu bar, select File Open Project to open your application. 

3. Select Insert Driver from the main menu bar to open the Communication drivers dialog.  

4. Select the GFLUX driver from the Available Drivers list (as shown in the following figure), and then click the 
Select button.  

 

Communication Drivers Dialog Box 

5. When the GFLUX driver displays in the Selected Drivers list, click the OK button to close the dialog. 

 

 Note:    

It is not necessary to install any other software on your computer to enable communication between the 
host and the device. 

 
 

 Attention:    

For safety reasons, you must use special precautions when installing the physical hardware. Consult the 
hardware manufacturer’s documentation for specific instructions in this area. 
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Configuring the Driver  

After opening Studio and selecting the GFLUX driver, you must configure the driver. Configuring the GFLUX 

driver is done in two parts: 

 Specifying communication parameters 

 Defining tags and controls in the STANDARD DRIVER SHEETs (or Communication tables) 

Worksheets are divided into two sections, a Header and a Body. The fields contained in these two sections 

are standard for all communications drivers — except the Station, Header, and Address fields, which are driver-

specific. This document explains how to configure the Station, Header, and Address fields only. 

 

 Note:    

For a detailed description of the Studio STANDARD DRIVER SHEETs, and information about configuring 
the standard fields, review the product’s Technical Reference Manual.  

 

Setting the Communication Parameters 

Use the following steps to configure the communication parameters, which are valid for all driver worksheets 
configured in the system: 

1. From the Studio development environment, select the Comm tab located below the Workspace. 
2. Click on the Drivers folder in the Workspace to expand the folder.  
3. Right-click on the GFLUX subfolder and when the pop-up menu displays (as shown in the following figure), 

select the Settings option. 

 

Select Settings from the Pop-Up Menu 

The GFLUX: Communications Parameters dialog displays (as follows). 

 

Communication Parameters Dialog 
 
This Driver does not have custom parameters. 
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4. Click the Advanced button on the Communication Parameters dialog to open the Advanced Settings dialog and 

configure the settings that are necessary. 
 

 Notes:    

 Do not change any of the other Advanced parameters at this time. You can consult the Studio 
Technical Reference Manual for information about configuring these parameters for future reference. 

 Generally, you must change the Advanced parameter settings if you are using a DCE (Data 
Communication Equipment) converter (232/485 for example), modem, and so forth between the  
PC, driver, and the host. You must be familiar with the DCE specifications before adjusting these 
configuration parameters.  
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Configuring the Driver Worksheets 

This section explains how to configure the STANDARD DRIVER SHEETs (or communication tables) to associate 

application tags with the device addresses. You can configure multiple Driver Worksheets — each of which is 

divided into a Header section and Body section.  

Configuring the STANDARD DRIVER SHEET 

 

Use the following steps to create a new STANDARD DRIVER SHEET: 

1. From the Studio development environment, select the Comm tab, located below the Workspace pane. 

2. In the Workspace pane, expand the Drivers folder and right-click the <Driver Name> subfolder.  

3. When the pop-up menu displays (as shown in the following figure), select the Insert option. 

 

Inserting a New Worksheet 

 

 Note:  

To optimize communication and ensure better system performance, you must tie the tags in different 

driver worksheets to the events that trigger communication between each tag group and the period in 

which each tag group must be read or written. Also, we recommend configuring the communication 

addresses in sequential blocks to improve performance. 

 

 

The STANDARD DRIVER SHEET displays (similar to the following figure). 

 

STANDARD DRIVER SHEET 
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In general, all parameters on the Driver Worksheet (except the Station, Header, and Address fields) are standard 

for all communication drivers, but they will not be discussed in this document. For detailed information about 

configuring the standard parameters, consult the Studio Technical Reference Manual.  

4.   Use the following information to complete the Station, Header, and Address fields on this worksheet.  

 Station field: Specify the device using the following syntax: 

<PLC ID>  

Where: 

– PLC ID is the PLC identification number. 

 Header field: Use the information in the following table to define the type of variables that will be read from 
or written to the device and a reference to the initial address. (Default value is ALL:0) 

 These variables must comply with the following syntax: 

<Command>:<Zone>:[Volatile] (For example: ALL:10) 

Where: 

– Command is the register type. (ALL, TEMP, ACTOUT, LDCURR, LDVLT, ALRST, MODE, CYCLE, 

PROCSET, PWRSET or ZONE) 

– Zone is the Zone Number. 

– Volatile is for Write operations in Volatile Memory 

After you edit the Header field, Studio checks the syntax to determine if it is valid. If the syntax is incorrect, 

Studio automatically inserts the default value in the Header field. 

Also, you can type a tag string in brackets {Tag} into the Header field, but you must be certain that the tag’s 

value is correct and that you are using the correct syntax, or you will get an invalid Header error.
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The following table lists all of the data types and address ranges that are valid for the GFLUX driver. 

 

Header Field Information 

Data 
Types 

Sample 
Syntax 

Valid Range of Initial  
Addresses per Worksheet 

Comments 

ALL ALL:12 Varies according to the equipment 
Set of five predefined values: Process Temperature Value, Active % Output, Load 
Current, Load Volts and Alarm Status. 

TEMP TEMP:0 Varies according to the equipment Process Temperature value ( .1o F ) 

ACTOUT ACTOUT:3 Varies according to the equipment Active % Output ( .1% ) 

LDCURR LDCURR:6 Varies according to the equipment Load Current ( .01A ) 

LDVLT LDVLT:11 Varies according to the equipment Load Volts ( 1V ) 

ALRST ALRST:1 Varies according to the equipment 

Alarm Status 

 Bit 0: Thermocouple open 

 Bit 1: Thermocouple Reversed 

 Bit 2: Uncontrolled Output 

 Bit 3: Heater Shorted 

 Bit 4: Heater Open 

 Bit 5: Open Fuse 

 Bit 6: Local Deviation High 

 Bit 7: Local Deviation Low 

 Bit 8: Thermocouple Shorted 

 Bit 9: Undefined 

 Bit 10: Zone Off 

 Bit 11: Manual Mode 

 Bit 12: Auto Standby 

 Bit 13: Control Inhibit 

 Bit 14: Power Up Reset 

 Bit 15: General Error 

MODE MODE:25 Varies according to the equipment Manual Mode (True/False) 

CYCLE CYCLE:0 Varies according to the equipment Cycle Time ( .1 Sec ) 

PROCSET PROCSET:1 Varies according to the equipment Process Setpoint ( .1oF ) 

PWRSET PWRSET:8 Varies according to the equipment Manual % Power Setpoint ( .1% ) 

ZONE ZONE:5 Varies according to the equipment Zone On/Off (True/False) 

 

 Address field: Use this field to associate each tag to its respective device address. 

Type the tag from your application database into the Tag Name column. This tag will receive values from or 
send values to an address on the device. The address must comply with the following syntax: 

 <ZoneOffset>:<Type>.[Bit] for “ALL” Headers (For example: ALL:LDCURR) and 

 <ZoneOffset>.[Bit] for any other Header (For example: 10, 20, 40, 10.5). 

Where:  

– ZoneOffset is a parameter added to the Zone parameter (configured in the Header field) to compose the 

group address configured in the Header field.  

– Type is used only with “ALL” Header. Used to specify the value/Setpoint of Zone to be read (TEMP, 

ACTOUT, LDCURR, LDVLT or ALRST) 
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– Bit (optional parameter) is the bit number to be read from the device. 

 

Attention:  

This driver supports bit reading only; it cannot execute bit writing. 

 

 

 

Address Configuration Sample 

Device Address  Header Field Address  Field  

Zone 1: Temp TEMP:0 1 

Zone 1: Temp TEMP:1 0 

Zone 1:Temp ALL:0 1:TEMP 

Zone 10: Cycle CYCLE:5 5 

Zone 10: Cycle CYCLE:0 10 

Zone 12: Alarm Status 
(Control Inhibit ) 

ALRST:12 0.13 

Zone 12: Alarm Status 
(Heater Open) 

ALRST:0 12.4 

Zone 12: Alarm Status 
(Heater Open) 

ALL:5 5:ALRST.4 

Zone 5: Process 
Setpoint 

PROCSET:2 3 

 
 

Attention:  

You must not configure a range of addresses greater than the maximum block size (date buffer length) 

supported by each PLC within the same worksheet. The maximum data buffer length for this driver is 

16 zones per STANDARD DRIVER SHEET. 


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Executing the Driver  

After adding the GFLUX driver to a project, Studio sets the project to execute the driver automatically when you 

start the run-time environment.  

To verify that the driver run-time task is enabled and will start correctly, perform the following steps: 

1. Select Project → Status from the main menu bar. 

The Project Status dialog box displays, as follows.  

 

Project Status Dialog Box 

2.   Verify that the Driver Runtime task is set to Automatic. 

 If the setting is correct, click OK to close the dialog box.  

 If the Driver Runtime task is set to Manual, select the Driver Runtime line. When the Startup button 
becomes active, click the button to toggle the Startup mode to Automatic.  

3.   Click OK to close the Project Status dialog.  

4.   Start the application to run the driver. 
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Troubleshooting 

If the GFLUX driver fails to communicate with the device, the tag you configured for the Read Status or Write Status 

fields will receive an error code. Use this error code and the following table to identify what kind of failure 

occurred.  

 

Error Code Description Possible Causes Procedure to Solve 

0 OK Communication without problems None required. 

1 
PROTOCOL 
ERROR 

Protocol error Contact your Studio technical support representative. 

2 CHECK SUM Check Sum error Contact your Studio technical support representative. 

3 
INVALID 
COMMAND 

Try Write “ALL” register type Cannot write “ALL” register type. 

4 BIT WRITE Try bit Write Cannot write bits. 

-15 
Timeout Start 
Message 

 Disconnected cables 
 PLC is turned off, in stop mode, or in error mode 
 Wrong station number 
 Wrong RTS/CTS control settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

-17 
Timeout between 
rx char 

 PLC in stop mode or in error mode 
 Wrong station number 
 Wrong parity 
 Wrong RTS/CTS configuration settings 

 Check cable wiring. 
 Check the PLC state – it must be RUN. 
 Check the station number. 
 Check the configuration. See Studio Technical 

Reference Manual for information about valid 
RTS/CTS configurations. 

 

 

 Tip:  

You can verify communication status using the Studio development environment Output window (LogWin 

module). To establish an event log for Field Read Commands, Field Write Commands, and Serial Communication, 

right-click in the Output window. When the pop-up menu displays, select the option to set the log events. If 

you are testing a Windows CE target, you can use the Remote LogWin of Studio (Tools  Remote Logwin) to 

get the log events from the target unit remotely. 

 

If you are unable to establish communication with the PLC, try to establish communication between the PLC 

Programming Tool and the PLC. Quite frequently, communication is not possible because you have a hardware 

or cable problem, or a PLC configuration error. After successfully establishing communication between the 

device’s Programming Tool and the PLC, you can retest the supervisory driver. 

To test communication with Studio, we recommend using the sample application provided rather than your new 

application. 

If you must contact us for technical support, please have the following information available: 

 Operating System (type and version): To find this information, select Tools → System Information.  

 Studio version: To find this information, select Help → About. 
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 Driver Version: To find this information, read the full description of the driver on the Communication Drivers 

Dialog Box. 

 Communication Log: Displays in the Studio Output window (or LogWin window) when the driver is running. Be 

sure to enable the Field Read Commands, Field Write Commands, and Serial Communication for the LogWin window. 

 Device Model and Boards: Consult the hardware manufacturer’s documentation for this information. 
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Sample Application 

 

You will find a sample application for drivers in the /COMMUNICATION EXAMPLES/<Driver Name> directory. 

We strongly recommend that you check if there is a sample application for this driver and use it to test the driver 

before configuring your own customized application, for the following reasons: 

 To better understand the information provided in each section of this document. 
 To verify that your configuration is working satisfactorily. 
 To certify that the hardware used in the test (device, adapter, cable and PC) is working satisfactorily before 

you start configuring your own, customized applications. 
 

Note:  

This application sample is not available for all drivers.  

 

Use the following procedure to perform the test: 

1. Configure the device’s communication parameters using the manufacturer’s documentation. 

2. Open and execute the sample application. 

 Tip:  

You can use the sample application screen as the maintenance screen for your custom applications.  
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